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1

Introduction

Overview
The upgrade kit is used to convert a CETAC ASX-520 or ASX-520HS
autosampler into a multi-use autosampler/SDS-550 sample dilution system.
NOTE

After you follow the instructions in this Upgrade Installation Guide, refer to the
SDS-550 Sample Dilution System Operator's Manual for information on how to
configure, use, and maintain the system.
The Operator's Manual can be found on the included CD or downloaded from
www.cetac.com.

Figure 1-1. SDS-550 System (Autosampler plus Dilution Module).
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The SDS-550 sample dilution system provides automated sample dilution that
enables you to perform other tasks while the SDS-550 runs. The SDS-550 can
automatically dilute up to 180 samples when fully loaded.
The SDS-550 system is typically controlled by a host computer using a serial
communications protocol.
The complete sample dilution system will include:
 An ASX-520 or ASX-520HS autosampler

WARNING

 The SDS-550 sample dilution module

MECHANICAL, ELECTRICAL, AND CHEMICAL HAZARDS.
Refer to the Operator's Manual for safety-related warnings and notices
before you use the SDS-550 sample dilution system.

Autosampler Compatibility
To install the SDS-550 upgrade kit, you must have an ASX-520, ASX-520HS,
EXR-8, or EXR-8HS autosampler with one of the following personalities:

Name

Personality Number

ASX-520, CETAC Standard

0*

ASX-520, Perkin Elmer

4

ASX-520, HP/Agilent

5

ASX-520, CETAC Standard, High Speed

14*

ASX-520, HP/Agilent, High Speed

15

ASX-520, Perkin Elmer, High Speed

16

ASX-520, MicroMass

17

ASX-520, Thermo AA, NJA

18

ASX-520, Thermo AA, NJA High Speed

20

ASX-520, Thermo-Finnigan (MAT)

22

EXR-8, CETAC Standard

23*†

EXR-8, CETAC Standard, High Speed

24*†

EXR-8, Perkin Elmer

25†

EXR-8, Perkin Elmer, High Speed

26†

*Includes OEM versions, such as Varian and Thermo versions
†EXR-8 will use racks 1-4 only, when used with SDS-550
The autosampler must have an on-board peristaltic rinse pump and rinse
station.

The autosampler must have either no auxiliary I/O card or an auxiliary I/O
card with a male connector installed. If an auxiliary card with a female
connector is installed, the upgrade kit is not compatible with the autosampler.
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Determining the Current Personality Using a Terminal
Program

1

Connect to the autosampler.

All CETAC autosamplers can be controlled using a serial communications
protocol. You can use any terminal emulation program, including:

2

 C-Term. (recommended) This program is installed with the Xpress
Configuration Tool software, and runs on Windows 2000 and later. See
“Using C-Term™” on page 25.
 HyperTerminal. This program was supplied with versions of the Windows
operating system through Windows XP. See “Using HyperTerminal” on
page 28.

To see a description which includes the personality name, enter the command

VERSS

3

To see the personality number, enter the command
GETTYPE

If you have any questions regarding how to identify your current autosampler
personality setting, please contact CETAC Technologies at www.cetac.com.

Parts Supplied
The upgrade kit includes:
















SDS-550 sample dilution module
ASX-520 I/O board with mounting screws
Desktop "brick" power supply, with power cords
Carbon fiber probe (1 mm I.D.)
Probe clamps
Fittings and ferrules
Tubing
Auxiliary communication cable
Serial communication cable
Diluent bottle
Reagent bottle
Vials (quantity 240)
Vial racks (60-position, quantity 4)
This Installation Guide
CD-ROM
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2 Installing the I/O Card
Purpose of the I/O Card
There are two communication links between the autosampler and the sample
dilution module. A serial link passes commands to the syringe pump. An
auxiliary link operates the reagent/sample switching valve.

An auxiliary I/O card must be installed in the autosampler so that the
autosampler can operate the reagent/sample switching valve.

Figure 2-1. Auxiliary I/O Card with Male Connector

WARNING

If your autosampler already has an auxiliary I/O card with a male connector,
skip ahead to "Installing the Probe and Tubing" on page 17.

ELECTRICAL AND MECHANICAL HAZARDS
Make sure the unit is off and unplugged before beginning this procedure.

Tools Required
You will need the following tools:
 Phillips-head screwdriver

 Nut driver 3/16”
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1

2

Set autosampler on flat surface.

Figure 2-2. ASX-520

Remove two Kynar thumbscrews from the Y-axis home block.

Figure 2-3. View of Y-axis home block wit Kynar thumbscrews

10

SDS-550 Upgrade Installation Guide
Chapter 2: Installing the I/O Card

3

4

Remove the whole Z-drive assembly from the arm by sliding to the end of the
autosampler arm tube.

Figure 2-4. Z-drive removed

Remove the rinse station. Turn the rinse station 1/4 turn counter-clockwise
while sliding upward.

Figure 2-5. Rinse station
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5

6

7

Remove the tray from the autosampler. Lift up and pull forward.

Figure 2-6. Removing tray from autosampler

Remove the four corner screws from the top cover.

Figure 2-7. Top cover screw locations

Remove the top cover.

Figure 2-8. Removing top cover
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8

9

10

Remove the 5 screws that attach the two shield pieces.

Figure 2-9. Shield screw locations.

Remove the two shield pieces. Notice that the splashguard goes under the
chassis on the top and over the chassis on the bottom. When you replace the
splashguard on re-assembly, ensure it is oriented in this manner.

Figure 2-10. Splashguard placement

Remove the splashguard by pulling it out from one side. It may be necessary to
reach under the guard and remove it from the support stand-offs.

Figure 2-11. Splashguard removal
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12

Unplug all connections from the main board, including pump (if equipped),
blue ribbon cable, z-sensor and z-motor, x-motor, and power entry cable.

13

Figure 2-12. Main board mounting screws

14

Figure 2-13. Heat sink nut and comm. port retaining strap

15

Remove the 6 screws that mount the main board.

Remove the ¼” nut holding the heat sink for the voltage regulators and the
mounting screw for the communications port retaining strap.

Remove the cover over the Auxiliary port on the rear panel on the autosampler.
Install daughterboard. Make sure to align the connectors on the I/O board
properly with the pins on the main board.

Figure 2-14. Daughterboard (I/O board) location
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17
18

Ensure bottom voltage regulator heat sink is in place against the chassis before
placing main board in the autosampler.
Reinstall the main board in the chassis by reinserting and tightening the 6
mounting screws.

19

Replace voltage regulator heat sink straps evenly and then tighten down 1/4”
nut. (Figure 2-13)

20

Figure 2-15. Jackscrews securing daughterboard

21
22
23
24
25

Insert and tighten jack screws in daughterboard on rear panel using a 3/16”
nut driver. (Figure 2-15)

Replace the communication port mounting strap and screw. Ensure that the
nut in the communications port retaining strap is oriented away from the
chassis to ensure it is not pulled out of the strap when tightened. (Figure 2-13)
Reattach all wiring connectors to their matching board connectors.

Replace splashguard. Make sure to route the blue ribbon cable under and to
the left end then upward.

Replace the shield cover with the 5 screws. Route blue ribbon cable through
the notch in the bottom shield.
Replace the cover, tray, rinse station, Z-drive assembly, and racks.
Power up and test operation.
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3

Installing the Probe
and Tubing
INJURY HAZARD
Ensure that AC power to the autosampler is off before proceeding with
installation. If power to the autosampler is not turned off, the autosampler
could begin moving while you are working on it.

WARNING

The plumbing connections should be made without using tools. In fact, using tools
such as screwdrivers or pliers to perform installation tasks may result in a damaged
or unusable instrument. Do not tighten fittings with anything other than your
fingers.

CAUTION

Installing the Sample Probe
1

To install the sample probe, complete the following steps:

If the Z-drive assembly has not yet been mounted on the autosampler, refer to
the SDS-550 Sample Dilution Operator's Manual.
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2
3
4
5

Figure 3-1. Z-Drive Assembly.

Install a clamp in the slot on the Z-axis slider. (Figure 3-1)

Install the sample probe through the Z-axis slider and then through the clamp.
(Figure 3-1)
Move the Z-axis slider plus attached sample probe to the top of the Z-axis
drive.

6

Leave approximately 10.5 centimeters of the sample probe’s yellow-colored
support tube extending above the top of the
Z-axis slider, (with the slider at the top of the Z-axis drive).

7

You can manually move the autosampler arm with attached z-axis drive to the
rinse station without damage to the autosampler.

Verify that the probe tip clears the top of the rinse station when the
autosampler is in the home position (Figure 3-1) above the rinse station.

Retain the sample transfer tubing with the spiral-wrap at tie points
approximately 15 and 40 centimeters above the top of the Z-axis drive, leaving
an untangled service loop of approximately 13 to 15 centimeters above the
probe.

The sample transfer tubing should still have slack remaining when the probe is
at the maximum downward limit.
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Setting the Z-Axis Travel
1
2

To set the Z-axis travel of the z-drive assembly, complete the following steps:

Adjust the Z-axis slider (with attached sample probe) so that the slider is
approximately 3-millimeters below the top of Z-axis drive. (Figure 3-1)

3

Rotate the Z-axis rotor clockwise so the rotor stop pin is against the rotor stop.

4

Ensure that the PEEK push-pull tube is fully located in the rotor clamp groove.
Otherwise the PEEK tube will slip, resulting in no movement of the Z-axis
slider.

Finger tighten the rotor clamp.

Manually rotate the Z-axis rotor back and forth several times and check for full,
unhindered movement of the Z-axis slider.
Do not maneuver the sample probe directly as damage may result.

CAUTION

5

Gently move the Z-slider until the gap between the slider and cap is
approximately 2 mm (1/16 inch).

Figure 3-2. Z-Drive Assembly with Z-Axis Slider.
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Figure 3-3. View of gap between probe bracket and cap (standard Z-drive).

Figure 3-4. View of gap between probe bracket and cap (carbon fiber style Zdrive assembly.).
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Connecting the Autosampler to the Dilution Module
There is one liquid connection between the autosampler and the dilution
module. One end of the autosampler probe is equipped with a ¼ • 28 Tefzel®
fitting (nut plus ferrule). This fitting is attached (finger tighten only) to the top
threaded port of the solenoid valve on the front of the dilution module.
To Dilution Probe

1
2
3
4
5
6
7

Figure 3-5. Autosampler Probe Connection to Solenoid Valve.
Pass the tubing through the nut.

Place the ferrule on the end of the tubing.
Very gently screw the nut into the valve.
Push the tubing all the way in.

Tighten the nut with your fingers.
Remove the nut.

Trim off any tubing which extends beyond the ferrule.

If the tubing extends too far into the valve, liquid flow may be obstructed

Cut Tubing Here

8

Figure 3-6. Trimming Off the Excess Tubing

Reinstall the nut and tighten using your fingers.
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Completing the Installation
The autosampler is now ready to for use with the SDS-550 sample dilution
system. Refer to the Operator's Manual on the CD to finish setting up the SDS550 sample dilution system. You will need to accomplish the following tasks:
 Connect the rinse station.

 Assemble and place the sample vial racks. Note that the standards vials are
not needed when the autosampler is operating as a dilution system.
 Connect the autosampler to the dilution module.

 Connect the autosampler and dilution module to a power source.

 Connect the communication cables between the autosampler and the host
computer, and between the autosampler and the dilution module.

 Verify the installation. Note that you will need a terminal emulator program
to test communication. In most cases, use C-TERM (page 25 of this guide) in
place of HyperTerminal as described in the Operator's Manual.

C – Serial ports

A – Peristaltic
pump

B – Auxiliary
port

Figure 3-7. Completed Installation—Back View (see Operator's Manual).
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Using the System as an Autosampler
After installing the upgrade kit, it is easy to switch between operation as an
autosampler and operation as a dilution system.

The dilution probe and the autosampler sample probe may both be connected
to the autosampler at the same time.

For Autosampler Operation

1
2
3
4
5
6

If the sample dilution module will not be used for a long time, flush and drain
the tubing, turn the power switch off, and unplug the power supply.
Remove the dilution probe from the Z-drive assembly.
Set the dilution probe aside.

If necessary, reinstall the standards vials.

Install the sample probe on the Z-drive assembly.
Set the probe height.

For Dilution Operation

1
2
3

Flush the sample probe and sample uptake tubing.

Remove the sample probe from the Z-drive assembly.

4

Set the sample probe aside.

5

The SDS-550 does not utilize the standards vials.

6
7
8
9

Remove the standards vials.

Install the dilution probe on the Z-drive assembly.
Turn on power to the autosampler.
Set the probe height.

Turn on power to the dilution module.
Start the software.
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4 Operating a CETAC
Autosampler Using a
Terminal Program
This chapter supplements the information in the "Verifying Installation"
chapter of the SDS-550 Sample Dilution System Operator's Manual.
NOTE

The terminal emulation program is used only to verify the communication link
to the autosampler; it is not used to operate the autosampler or SDS-550.
CETAC autosamplers can be controlled using a serial communications protocol.
You can use any terminal emulation program, including:
 C-Term. This program is installed with the Xpress Configuration Tool
software, and runs on Windows 2000 and later. (recommended)

 HyperTerminal. This program was supplied with versions of the Windows
operating system through Windows XP.
This chapter explains how to operate a CETAC autosampler using either of the
two programs.

Using C-Term™
C-Term is a simple terminal program developed to validate the installation and
functionality of various CETAC devices. C-Term communicates through a serial
(RS-232) port on the host computer. If the device is connected to a USB port,
the device driver will create a virtual serial port.
C-Term is provided on the CETAC software CD, or it can be downloaded from
the CETAC Web site.
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Starting C-Term

1

2

Check that the communication port connectors are properly attached between
the host computer and the CETAC device.
If the communications interface between the CETAC device and the host
computer is not established correctly, the device will not function.

On the Start Menu, click All Programs, then CETAC Xpress Config, then Support
Tools, then C-Term.

Figure 4-1 Starting C-Term

Overview of the C-Term Window
Once C-Term is loaded, the window shown in Figure 4-2 will open. The
majority of C-Term’s functions are available from this window.

Figure 4-2 C-Term Window

By default, typed commands are sent to the CETAC device connected to the
opened port. The typed commands will appear in light green in the terminal
buffer. Responses from the device will appear in red. Non-printing characters
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such as carriage returns will appear as ASCII hexadecimal numbers
surrounded by square brackets, for example, [0D] is the carriage return
character.

Figure 4-3 Outgoing commands shown in green and incoming responses
shown in red

Configuring C-Term

By default, C-Term attempts to open COM1 the first time it is executed. If the
COM port that the CETAC device is connected to is not the default (COM1), then
it will be necessary to configure C-Term to use the desired port.

The default communications configuration is appropriate for use with the vast
majority of CETAC devices. Exceptions are the ASX-8000 which requires a baud
rate change and the AS300 emulator which uses non-printing characters are
part of its command protocol. Modifying the default settings is described
below.
NOTE

If COM1 (or the currently selected COM port) is in use by another program or
is otherwise unavailable, a warning dialog box will pop up when C-Term starts
stating that the COM port could not be opened.

1

On the Tools menu, click Setup Serial Port.

Figure 4-4 Serial Port Setup Window
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2

Select the desired COM port and, if necessary, the Baud rate used by the
connected device then click OK.

The window will close and the settings will be saved. These new settings
will be applied immediately and used thereafter unless changed again.

NOTE

Except for the ASX-8x00, all CETAC devices communicate at 9600 baud (which
is the default.)
NOTE
Only installed COM ports, including USB virtual COM ports, will appear in the
Comm Port menu.

Setting Preferences

1

If desired, the size of the scrollback buffer or the color of the outgoing and
incoming texts can be changed (to work around color blindness, for example).

On the Tools menu, click Preferences.

Figure 4-5 Preferences Window

To change the Scrollback Buffer Length, either type the new value in the
field or use the arrows adjust the value up or down.

2

To change text color, click on the color bar and a color selection dialog box
will appear. Select the new color and click OK.

Click Save to apply your settings and close the window.

Using HyperTerminal
1

Using a serial cable, connect the CETAC autosampler with the computer. Plug
each end of the serial cable into the COM 1 port of the autosampler and the
computer, respectively.
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2
3

4

5

Turn on the computer and select the Accessories folder. Select the
HyperTerminal folder and then the HyperTerminal program.

A window will appear as in Figure 4-6. Enter COM 1 in the name box. Press the
OK button.

Figure 4-6 “Connection Description” Window

In the Connect To window, set Connect Using to COM 1, then click OK.

Figure 4-7 “Connect To” Window

In the Properties window, set Bits per second to 9600 and Flow control to
None.
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Figure 4-8

6

Click OK.

“COM1 Properties” Window

The HyperTerminal window will open.

Figure 4-9 “Com 1 Hyperterminal” Window
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7
8

On the File menu, click Properties.

On the Settings tab, click ASCII Setup

Figure 4-10

9

Click ASCII Setup.

“Com 1 Properties” Window
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10

Enable “Echo typed characters locally” and “Append line feeds to incoming line
ends,” then click OK.

Figure 4-11

11

Turn on the autosampler.

“ASCII Setup” Window

The HyperTerminal window should display an OK.
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